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        Users trust to manage documents on pdfFiller platform

        
                                                
                        65.5K+

                        documents added daily

                    

                                    
                        53%

                        of documents created 
from templates

                    

                                    
                        4M

                        PDFs edited per month

                    

                                    
                        238K

                        documents shared 
per month

                    

                                    

    


            
    
        
            
                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
            

            
                                    
                        Start free trial
                    
                            

            

            

        

    


                                                
            
                    
        Learn how to Create Dropdown List DOCX in pdfFiller
    


            Microsoft Word is primarily an editable format that you could personalize to your specifications by adding and removing content material. Basically, it tends to make managing files appear like a simple job. Just open a file and alter whatever you'd like without having added tools. However, a major downside is such easy actions are not possible for macOS customers.

                pdfFiller can are available in handy. The service has in depth tools that offer you with high-quality outcomes. Create Dropdown List DOCX, turn files into dynamic forms, and leave paper-based workflow previously. Plus, all the tools are obtainable to you from any device because the online editor runs efficiently from any browser. You just need a World Wide Web connection to enhance your template.

                pdfFiller features a user-friendly interface, so you skip the standard time-consuming learning stage and commence with editing. If you would like to Create Dropdown List DOCX, you can do it in clicks. Maintain tools at your fingertips and modify documents within the easiest way without scanning, printing, and overpriced software. Grasp how to use pdfFiller's tools and Create Dropdown List DOCX within the easiest way. Verify out the directions under.

                How to Create Dropdown List DOCX:

                
                        
                                    01

                    
                        Create an account. Fill out the registration form manually or using Social Login (Facebook and Google).
                    

                            

                        
                                    02

                    
                        Upload documents by clicking the Add New button. Drag and drop files from a desktop or cloud storage. Paste a URL to import files from online.
                    

                            

                        
                                    03

                    
                        Wait till the file is ready and continue editing.
                    

                            

                        
                                    04

                    
                        Look through the toolkit and pick an instrument you want to apply to your file. Add fillable fields, delete the original content, include images, etc.
                    

                            

                        
                                    05

                    
                        Click Done to save your modifications.
                    

                            

                        
                                    06

                    
                        To find your updated template, go to the Documents tab.
                    

                            

                        
                                    07

                    
                        Transform the file towards the suitable format or print it out.
                    

                            

                    

                pdfFiller is really a web-based service that suits macOS and Windows users. Verify out your all-encompassing answer to handle files seamlessly.
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                    Related features
                

                
                                            
                            Slide Texture in the Commercial Lease Agreement with ease
                        

                                            
                            Slide Texture in the Deed Of Trust with ease
                        

                                            
                            Slide Texture in the Property Management Agreement with ease
                        

                                            
                            Slide Texture in the Rent-to-Own Agreement with ease
                        

                                            
                            Slide Texture in the Affidavit Of Domicile with ease
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        How to Use the Create Dropdown List DOCX without MS Word Feature
    


            Thank you for choosing pdfFiller! We are here to guide you through the process of using the Create Dropdown List DOCX without MS Word feature. Follow the steps below to easily create a dropdown list in your document:

                
                        
                                    01

                    
                        Login to your pdfFiller account or sign up for a new account if you don't have one already.
                    

                            

                        
                                    02

                    
                        Upload the DOCX file that you want to add a dropdown list to. You can do this by clicking on the 'Upload' button on the top right corner of the dashboard and selecting the file from your computer.
                    

                            

                        
                                    03

                    
                        Once the file is uploaded, click on it to open it in the pdfFiller editor.
                    

                            

                        
                                    04

                    
                        In the editor, navigate to the 'Form' tab located on the left side of the screen.
                    

                            

                        
                                    05

                    
                        Click on the 'Dropdown' button in the 'Form' tab to add a dropdown list to your document.
                    

                            

                        
                                    06

                    
                        A dropdown list will appear on your document. You can customize the options in the list by clicking on the 'Edit' button next to the dropdown list.
                    

                            

                        
                                    07

                    
                        In the 'Edit Dropdown' window, you can add, remove, or edit the options in the dropdown list. Click on the 'Save' button once you are done.
                    

                            

                        
                                    08

                    
                        You can resize and reposition the dropdown list by clicking and dragging it to the desired location on your document.
                    

                            

                        
                                    09

                    
                        Save the changes you made to your document by clicking on the 'Done' button on the top right corner of the editor.
                    

                            

                        
                                    10

                    
                        You can now download the updated DOCX file with the dropdown list by clicking on the 'Download' button on the top right corner of the dashboard.
                    

                            

                    

                That's it! You have successfully created a dropdown list in your DOCX file without using MS Word. If you have any further questions or need assistance, feel free to reach out to our support team. Happy form filling!

            

    
                
    
        What our customers say about pdfFiller

        See for yourself by reading reviews on the most popular resources:
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                            4,6

                        

                        661 Reviews

                    

                

            
                    
                        [image: Shopper Approved Logo]
                    

                    
                        
                            
                                    
                                
                            

                            4,4

                        

                        95k Reviews
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                            4,6

                        

                        9k Reviews

                    

                

        

                    
                                    
                        
                            
                                
                                    Kim

                                    

                                

                                
                                    2015-10-02

                                

                            

                            
                                
                                    I have found forms through PDFfiller that I could not locate anywhere else--wonderful tool!

It's fairly intuitive, but there are some cumbersome issues related to printing--too many steps--could be simplified.
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                                    Steven S

                                    

                                

                                
                                    2018-05-07

                                

                            

                            
                                
                                    great I run a water and sewage restoration business and this had made it possible to do all my emails and bids in the field. This program has made me thousands of dollars. As a business owner with no computer traning and self taught to pick at a keyboard. I now can compete with the business who run 5 employees doing paperwork and emails. This allows me to do the work of 4.
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                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC
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                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play
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                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store

                

            

        

    


    
    
        
            
                
                    pdfFiller scores top ratings in multiple categories on G2
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            Related searches to Create Dropdown List DOCX

            
                                    how to create multiple selection drop down list in word

                                    how do you create a drop down list with multiple selections in word 2016

                                    how to create multiple drop-down list in word 2019

                                    how do you create a drop down list with multiple selections in excel

                                    how to create multiple drop down list in word 2010

                                    how to create drop-down list in word 2016

                            

        

    
                
        
            
                                    FAQ on How to Create Dropdown List DOCX
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
How do I make a group drop down list in Word?
                        

                                                    In Word, open a blank document and click the Developer tab. (If you don't know how to enable the Developer tab, read How to: Show the Developer Tab on the Ribbon. ) In the Controls group, click the Legacy Form dropdown and choose Drop-Down Form Field. Repeat step 2 to add a second dropdown field.

                                            

                                    
                        
                            
How do you create a drop-down list with multiple selections in Word 365?
                        

                                                    Place the cursor in the form where you want the multi-selection list and then go to the Controls Task Pane (View > Design Tasks > Controls). Under the Repeating and Optional section, click Multiple-Selection List Box. Configure the multi-select list box as you would a standard List Box.

                                            

                                    
                        
                            
Can you select multiple items from a drop-down list in Word?
                        

                                                    Users can select only one item from a drop-down list. Combo box If you want your users to be able to type their own list entry or choose a value from a predefined list, use a combo box instead of a multiple-selection list box. Users can select only one item from a combo box.

                                            

                                    
                        
                            
How do you create drop down boxes in Word?
                        

                                                    Insert a combo box or a drop-down list to Developer > Combo Box Content Control or Drop-Down List Content Control. Select the content control, and then select Properties. To create a list of choices, select Add under Drop-Down List Properties. Type a choice in Display Name, such as Yes, No, or Maybe. More items

                                            

                                    
                        
                            
Does Word have dropdown boxes?
                        

                                                    There are two drop-down box options in Word. The Drop-Down List is to allow the reader to select one of the options you specify. The Combo Box includes the answers you specify, but also gives readers the opportunity to type their own option.

                                            

                                    
                        
                            
How do you create a drop-down list with multiple selections in Word?
                        

                                                    Place the cursor in the form where you want the multi-selection list and then go to the Controls Task Pane (View > Design Tasks > Controls). Under the Repeating and Optional section, click Multiple-Selection List Box. Configure the multi-select list box as you would a standard List Box.

                                            

                            

        

                                                                                                        
    
    
    
    
        
            

            
                eSignature workflows made easy
            

            
                Sign, send for signature, and track documents in real-time with signNow.
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            Last Name
            
        

        
            Email
            
        

        
            Country
            Select your country
Afghanistan
Åland Islands
Albania
Algeria
American Samoa
Andorra
Angola
Anguilla
Antarctica
Antigua & Barbuda
Argentina
Armenia
Aruba
Australia
Austria
Azerbaijan
Bahamas
Bahrain
Bangladesh
Barbados
Belarus
Belgium
Belize
Benin
Bermuda
Bhutan
Bolivia
Bosnia & Herzegovina
Botswana
Bouvet Island
Brazil
British Indian Ocean Territory
British Virgin Islands
Brunei
Bulgaria
Burkina Faso
Burundi
Cambodia
Cameroon
Canada
Cape Verde
Caribbean Netherlands
Cayman Islands
Central African Republic
Chad
Chile
China
Christmas Island
Cocos (Keeling) Islands
Colombia
Comoros
Congo - Brazzaville
Congo - Kinshasa
Cook Islands
Costa Rica
Côte d’Ivoire
Croatia
Cuba
Curaçao
Cyprus
Czechia
Denmark
Djibouti
Dominica
Dominican Republic
Ecuador
Egypt
El Salvador
Equatorial Guinea
Eritrea
Estonia
Eswatini
Ethiopia
Falkland Islands
Faroe Islands
Fiji
Finland
France
French Guiana
French Polynesia
French Southern Territories
Gabon
Gambia
Georgia
Germany
Ghana
Gibraltar
Greece
Greenland
Grenada
Guadeloupe
Guam
Guatemala
Guernsey
Guinea
Guinea-Bissau
Guyana
Haiti
Heard & McDonald Islands
Honduras
Hong Kong SAR China
Hungary
Iceland
India
Indonesia
Iran
Iraq
Ireland
Isle of Man
Israel
Italy
Jamaica
Japan
Jersey
Jordan
Kazakhstan
Kenya
Kiribati
Kuwait
Kyrgyzstan
Laos
Latvia
Lebanon
Lesotho
Liberia
Libya
Liechtenstein
Lithuania
Luxembourg
Macao SAR China
Madagascar
Malawi
Malaysia
Maldives
Mali
Malta
Marshall Islands
Martinique
Mauritania
Mauritius
Mayotte
Mexico
Micronesia
Moldova
Monaco
Mongolia
Montenegro
Montserrat
Morocco
Mozambique
Myanmar (Burma)
Namibia
Nauru
Nepal
Netherlands
New Caledonia
New Zealand
Nicaragua
Niger
Nigeria
Niue
Norfolk Island
North Korea
North Macedonia
Northern Mariana Islands
Norway
Oman
Pakistan
Palau
Palestinian Territories
Panama
Papua New Guinea
Paraguay
Peru
Philippines
Pitcairn Islands
Poland
Portugal
Puerto Rico
Qatar
Réunion
Romania
Russia
Rwanda
Samoa
San Marino
São Tomé & Príncipe
Saudi Arabia
Senegal
Serbia
Seychelles
Sierra Leone
Singapore
Sint Maarten
Slovakia
Slovenia
Solomon Islands
Somalia
South Africa
South Georgia & South Sandwich Islands
South Korea
South Sudan
Spain
Sri Lanka
St. Barthélemy
St. Helena
St. Kitts & Nevis
St. Lucia
St. Martin
St. Pierre & Miquelon
St. Vincent & Grenadines
Sudan
Suriname
Svalbard & Jan Mayen
Sweden
Switzerland
Syria
Taiwan
Tajikistan
Tanzania
Thailand
Timor-Leste
Togo
Tokelau
Tonga
Trinidad & Tobago
Tunisia
Turkey
Turkmenistan
Turks & Caicos Islands
Tuvalu
U.S. Outlying Islands
U.S. Virgin Islands
Uganda
Ukraine
United Arab Emirates
United Kingdom
United States
Uruguay
Uzbekistan
Vanuatu
Vatican City
Venezuela
Vietnam
Wallis & Futuna
Western Sahara
Yemen
Zambia
Zimbabwe
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            Company size
            Number of employees
0 - 5 employees
6 - 50 employees
51 - 200 employees
201 - 1000 employees
1001 - 2000 employees
2001 +  employees
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                                                By clicking “Talk to sales” I agree to receive email or phone communications about your services, offers, and promotions. We use your information as described in our Privacy Notice
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